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ОСОБЛИВОСТІ БАЗОВИХ ІНСТРУМЕНТІВ МОДЕЛЮВАННЯ  

3D-ОБ’ЄКТІВ У SKETCHUP 
 
В статті розглянуто і досліджується особливості використання базових інструментів для моделювання 

тривимірних об’єктів у програмі SketchUp. Описано основну властивість пакету - інструмент Push/Pull («Тягни/ 

Штовхай»), завдяки якому будь-яку площину можна «витягнути» в сторону, створивши по мірі її руху нові бокові 
стінки. 

Розглянуто найпоширеніші на ринку програмні пакети для моделювання, проведено порівняння базових 
можливостей SketchUp та інших пакетів, виділено напрямок роботи з геометрією моделей. Описано основні 
інструменти для керування 3D-об’єктами у SketchUp, основи процесу візуалізації. 
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THE FEATURES OF BASIC MODELING TOOLS OF 3D OBJECTS IN SKETCHUP 
 

Recently, the intuitive-oriented program for designers and architects, which is used to quickly create three-dimensional models of 

objects, structures, buildings and interiors - SketchUp, has gained widespread recognition in the world of 3D. So now almost all other developers 

include in their software products or direct support for models (files) SketchUp, or data exchange with it through special plug-ins. SketchUp is 

designed primarily for sketch, searchable 3D modeling in three-dimensional space. However, SketchUp is successfully used to develop a variety 

of projects in all genres of design, advertising, engineering design, film and game production. 

The saltation in the increasing popularity of SketchUp has occurred since the program was "tied" to the new owner's Internet projects 

- Google 3D models and Google Earth. The reason for choosing and acquiring SketchUp by Google, apparently, was its simplicity and 

accessibility. By creating a model of an architectural structure or any other object in SketchUp, users could place their creations in the public 

online collections of Google. So, in particular, the selection of collections "Cities under development" contains several thousand models of real 

architectural buildings of the world. At the same time, Google accepted 3D models only with the requirement that they were textured and 

equipped with the correct geographical reference. Compared to many other popular packages, SketchUp has a number of features that are 

positioned as advantages. The main feature of this program is the almost complete absence of pre-configuration windows. All geometric 

characteristics during or immediately after the end of the tool are set from the keyboard in the Value Control Box. Another key feature is the 

Push/Pull tool, which allows any plane to be "pulled out" to the side, creating new side walls as it moves. You can move the plane against the 

predetermined curve, using a special tool Follow Me. The program is also characterized by extreme accuracy of calculations and measurements. 

Keywords: SkenchUp, 3D model, three-dimensional graphics, Push/Pull tool, visualization. 

 

Постановка проблеми у загальному вигляді  

та її зв’язок із важливими науковими чи практичними завданнями 

Тривимірна графіка настільки широко увійшла до нашого життя, що ми стикаємося з нею, часом 

навіть не помічаючи її. Область застосування тривимірної графіки надзвичайно широка: від реклами та 

кіноіндустрії до дизайну інтер'єру та виробництва комп'ютерних ігор. Наприклад, використання 

комп'ютерних технологій при проектуванні та розробці дизайну інтер'єру допомагає побачити кінцевий 

варіант задовго до того, як ситуація буде відтворена. 3D-графіка дозволяє створювати тривимірні макети 

різних об'єктів, повторюючи їх геометричну форму та імітуючи матеріал, з якого вони створені. Щоб 
отримати повне уявлення про певний об'єкт, необхідно оглянути його з усіх боків, з різних точок при 

різному освітленні. На ринку програмних засобів з обробки 3D-графіки для ПК на базі ОС Windows 

лідируючі позиції зайняли три пакети [1].  

Перша програма зі створення та обробки тривимірної графіки для ПК 3D Studio Max із самого 

початку була створена для платформи Windows [1, 4]. Вона є «напівпрофесійним додатком», але її функцій 

цілком достатньо для отримання потрібних тривимірних зображень. Головною особливістю пакета є 

підтримка великої кількості прискорювачів для 3D-графіки, сильні світлові ефекти, велика кількість 

доповнень, створених «третіми» фірмами. Програма не вимоглива до ресурсів системи, що дозволяє їй 

працювати на комп'ютерах навіть слабкої потужності. Але вона поступається конкурентам за функціями 

моделювання та анімації. 

Друга програма Softimage 3D спочатку створювалася для бази, заснованої на станції SGI і лише 
потім була підлаштована під операційну систему Windows. Програма відрізняється потужними 

можливостями моделювання, наявністю великої кількості спеціалізованих параметрів, що регулюються. Для 

програми створено багато доповнень, випущених іншими фірмами, що спричинило збільшення функцій 

пакета. Але ця програма в порівнянні з іншими вимагає більше ресурсів і виглядає важкувато [1, 2]. 

Третя програма Мауа – одна з найновіших з погляду інтерфейсів та можливостей. Пакет випущений 

відразу в декількох варіаціях для різних операційних систем, до їх складу увійшла і Windows. Інструменти 

Мауа зведені в чотири групи: анімація, моделювання, фізичне моделювання, візуалізація зображень і 

об'єктів. Зручний інтерфейс, що легко налаштовується, створений відповідно до всіх стандартів і вимог. 
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Сьогодні Мауа є найпоширенішою програмою зі створення та обробки 3D-графіки для ПК, не вимагає 

великих ресурсів [1, 2]. 

У типових 3D-додатках тримірний простір позначається трьома координатами – X, Y та Z. При 

цьому X-координата зазвичай позначає горизонтальний напрямок, Y-координата – вертикальний, а Z-

координата – глибину (у деяких додатках координати Y та Z міняються місцями). Кожна точка у 3D-

просторі має своє абсолютне положення у 3-мірному світі та прив'язана до певних глобальних світових 

координат. Крім того, ця ж точка має і локальні координати, якими визначається її місцезнаходження щодо 

інших частин об'єкта. 

 

Виклад основного матеріалу 

Тривимірна графіка – це щось середнє між комп'ютерною грою та зйомкою справжнього фільму. 

Процес створення тривимірного проекту поділяється на кілька обов'язкових та послідовних етапів. Вони 

однакові, незалежно від того, в якому 3D-редакторі виконується проект і який це проект. Тривимірний 

проект часто називають сценою [1, 2]. 

Моделювання. У тривимірному просторі 3D немає жодних предметів. Віртуальний світ 

наповнюється різними об'єктами, які створює користувач в 3D-редакторі. Це відноситься до тривимірних 

персонажів, будівель, гір, лісів та будь-яких інших речей віртуального світу. Процес створення тривимірних 

об'єктів називається моделюванням, а самі об'єкти – моделями. На відміну від мальованого зображення, 

тривимірну модель можна обертати та переміщати у трьох вимірах, дивлячись на неї з усіх боків. Залежно 

від того, який саме об'єкт потрібно створити, на його моделювання може піти від кількох секунд до кількох 

місяців. Наприклад, шафу можна зробити за пару хвилин, а створення людської голови може зайняти не 
один день. 

Анімація. На відміну від моделювання, анімація не є обов'язковим етапом створення тривимірних 

проектів Наприклад, якщо дизайнер працює над проектом інтер'єру квартири, йому не потрібно змушувати 

об'єкти рухатися, оскільки для такого проекту важливо показати зовнішній вигляд та розміщення предметів 

у приміщенні. Якщо ж створюється рекламний ролик чи якийсь ефект на зразок вибуху, то без анімації не 

обійтися. Анімація передбачає зміну положення об'єктів, які присутні в тривимірному просторі, у часі. 

Зйомка. Під час перегляду фільму або телепередачі ви можете помітити, що режисер часто змінює 

точку зйомки. Кінцевий продукт тривимірної анімації, по суті, є тим самим відео, яке може «зніматися» з 

різних точок, вибір точки зйомки у тривимірній анімації не менш важливий, ніж у цьому кіно або на 

телебаченні. Для знімання анімації, створеної в 3D-редакторі, застосовуються віртуальні камери, які можна 

переміщати, а також перемикатися між ними у процесі анімації. Віртуальні камери мають ті ж властивості, 
що й справжні: вони можуть фіксувати картинку під різним кутом зору, імітувати ефект глибини різкості 

тощо. 

Освітлення. Віртуальний простір, в якому працюють 3D-художники, на відміну від реального світу, 

немає джерел освітлення. Щоб побачити, що відбувається у віртуальному світі, його треба висвітлити. Для 

імітації освітлення у тривимірній графіці використовуються спеціальні об'єкти, які називаються джерела 

світла. Щоб освітлення 3D-об'єктів було схоже на справжнє, доводиться враховувати безліч факторів: де 

розташоване джерело світла, з якою силою воно світить, від яких предметів відбивається тощо. 

Текстурування. Усі предмети, з якими ми маємо справу у реальному житті, відрізняються один від 

одного зовнішнім виглядом. Об'єкти, створені у тривимірному просторі, на етапі моделювання 

відрізняються один від одного лише формою. Щоб 3D-модель нагадувала реальний предмет, недостатньо 

точно повторити його форму, потрібно ще й розфарбувати її належним чином. Процес розмальовки 

тривимірних об'єктів називається текстурування. В загальному сенсі слово «текстура» має дещо інше 
значення і означає особливості будови твердої речовини, зумовлені характером розташування його 

складових частин. У тривимірній графіці текстурою може бути як фотографія реального об'єкта, накладена 

на 3D-модель, так і двовимірний малюнок, створений у програмі типу Adobe Photoshop. 

Візуалізація. Послідовність виконання попередніх етапів створення тривимірного проекту може 

бути різною. Однак візуалізація завжди є останнім етапом роботи над проектом, без візуалізації робота в 3D-

редакторі не має жодного сенсу, оскільки без неї не можна отримати кінцевий результат. Візуалізацію 

тривимірного проекту можна порівняти зі зйомкою відеокамерою, проте готове відео чи статичне 

зображення у цьому разі записується не на касету, а файл. Візуалізацію також називають рендерингом, або 

прорахунком.  

Найпростішим способом створення нескладних об'ємних об'єктів і їх поєднань в середовищі є 

використання інтегрованого в ОС Windows 10 редактора Paint 3D. За допомогою інструменту можна швидко 
і легко створювати, а також редагувати моделі в тривимірному просторі. В той же час, найпопулярнішим 

представником 3D-моделей залишається Autodesk 3ds Max - найпотужніший, функціональний і 

універсальний додаток для тривимірної графіки. 3D Max – це стандарт, під який випущено безліч 

додаткових плагінів, розроблено готових 3D-моделей, відзнято гігабайти авторських курсів і відеоуроків. 

Останнім часом широкого визнання у світі 3D набула інтуїтивно-орієнтована програма для 

дизайнерів і архітекторів, яка використовується для швидкого створення тривимірних моделей предметів, 

конструкцій, будівель і інтер'єрів, - SketchUp. Тому майже всі сторонні розробники включають у свої 

програмні продукти або безпосередню підтримку моделей (файлів) SketchUp, або обмін даними з ним через 
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спеціальні плагіни. SketchUp (Sketch - ескіз, Up - вгору) призначений в основному для ескізного, 

пошукового 3D-моделювання в тривимірному просторі. Насправді, завдяки гнучкості закладених у ньому 

механізмів моделювання, можливості та області його застосування набагато ширші – SketchUp успішно 

використовують для розробки 

різноманітних проектів у всіх жанрах 

дизайну, реклами, інженерному 

проектуванні, кіно- та ігро-виробництві [3, 

5]. 

Тут же є відкрите діалогове вікно 

Instructor (Інструктор), в якому можна, 
вибираючи різні інструменти, 

продивитися анімовані міні-уроки по них і 

перейти на відповідні розділи сайту 

офіційного Help. 

Маючи дружній інтерфейс, 

SketchUp володіє чудовими можливостями 

для вирішення практично всіх основних 

завдань технічного 3D-моделювання, у 

тому числі високу точність та зручність 

побудов рівня професійних CAD редакторів. Спочатку встановлюються стандартні, попередньо обумовлені 

види (проекції). За ці опції відповідає наступна група інструментів навігації, панель яких викликаємо через 
головне меню View > Toolbars > Views (Види). Панель за замовчуванням поміщається в горизонтальний 

рядок панелей інструментів, розташовану під текстовими меню, над вікном моделювання. 

 

 
Рис. 2. Панель кнопок групи «Види» 

 
За порядком розміщення: Iso (Ізометрія); Top (Зверху); Front (Спереду); Right (Дело); Back (Ззаду); 

Left (Зліва). Крім того, є ще вид Bottom (Знизу), який не представлений кнопкою на панелі інструментів 

(такий, що рідко використовується) і доступний тільки з головного меню Camera > Standard Views 

(Стандартні види). 

Механізм «виходу в третій вимір», представлених у групі інструментів Modification Tools. 

Відкриваємо меню View > Toolbars, включаємо показ (ставимо відмітку) на пункті Modification 

(Модифікації) – блок їх кнопок додається до панелі інструментів. Як випливає 

із назви цієї групи, інструменти використовуються для модифікацій (змін, 

спотворень, редагування) об'єктів. У тому числі - для перетворення вже 

створених інструментами малювання плоских 2D-фігур у 3D-моделі, а також 

для змін положення (позицій), розмірів, пропорцій будь-яких існуючих об'єктів 
та їх окремих елементів. 

Такі інструменти мають потужні функції, пов'язані з вирішенням 

конкретних завдань моделювання. 

Push/Pull (Тягни/Штовхай). Створення в SketchUp всього різноманіття тривимірних об'єктів 

фактично засноване на використанні одного принципу – «виштовхування» або «витягування» плоских 2D-

поверхень у третій вимір. Отже, інструмент, який буквально працює на цьому принципі, дія якого зазвичай 

позначається в 3D-редакторах терміном Еxtrude - видавлювання. Інструмент не працює з ребрами, а тільки з 

Faces (Поверхнями) і тільки в напрямку, перпендикулярному (нормальному) самій вихідній поверхні. І ще – 

«за раз» можна застосувати інструмент тільки до однієї, одиничної поверхні, тобто він «не вміє» одночасно 

працювати з декількома (зібраним множинним вибором) поверхнями, що лежать навіть в одній площині. 

Якщо до поверхні, яку ми вибрали для Push/Pull, не можна застосувати цей інструмент, з'являється підказка 

поруч із курсором у вигляді символу «забороняючого знака». Такий типовий випадок – спроба «видавити» 
криволінійну (точніше – згладжену) 

поверхню, наприклад, бічну поверхню 

циліндра, оскільки в цьому випадку вона 

сприймається не як плоска. Є два варіанти 

застосування інструменту, точніше два 

варіанти послідовності дій: 

Спосіб 1. Якщо нічого в сцені не 

вибрано, то після розміщення курсору 

інструменту (який зміниться на його 

зображення) на поверхню автоматично 

відбувається її вибір, тому немає необхідності її попереднього вибору інструментом Select. Тобто тут немає 
необхідності попередньо клацати на поверхні, що витягується - досить просто переміщати курсор Push/Pull з 

натиснутою кнопкою мишки, і поверхня буде «слідувати» за ним. Для завершення опції відпускаємо кнопку 

 
Рис. 1. Робоче вікно програми 

 
Рис. 3. Панель кнопок групи 

«Модифікація» 

 
Рис. 4. Приклад роботи інструменту «Push/Pull» 
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миші у потрібний момент (при досягненні потрібної величини) [3]. 

Недолік цього методу, при всій його швидкості, полягає в тому, що при цьому поверхня, що 

витягується/вдавлюється, повинна бути постійно видною, перебувати в полі зору до завершення опції. При 

цьому часто бувають ситуації, коли зручніше змінити ракурс для точного завершення опції [3, 5]. 

Спосіб 2. Спочатку вибираємо потрібну поверхню, потім натискаємо кнопку інструмента. В цьому 

випадку у курсора з'являється синя точка, що говорить про те, що тепер курсором можна натискати в будь-

якому місці, вказуючи спочатку початкову точку, потім кінцеву, завершуючи опцію. При цьому між цими 

двома кліками можна як завгодно змінювати ракурс камери - інструмент пам'ятає вибрану для опції 

поверхню. 

Інструмент працює як у «позитивному», так і в «негативному» напрямку, що відповідає 
«зниженню» або «підвищенню» нового рівня щодо стартової поверхні. Ще одну додаткову функцію 

інструменту описує підказка у статусному рядку – «Ctrl = toggle create new starting face». Тобто, після 

вибору поверхні та натискання клавіші Ctrl (утримувати не обов'язково) опція завершуватиметься 

створенням нової стартової поверхні, яка при подальшому рухові курсору залишається на місці. Таким 

чином, фактично відбувається вплив не на саму обрану поверхню, а на копію, при цьому оригінал 

залишається на місці. І ще одна дуже корисна функція: якщо відразу після застосування на одній поверхні 

двічі швидко клікнути (подвійний клік) інструментом курсору на інший – буде виконана та ж дія на ту саму 

величину і в тому ж напрямку. 

Follow me (Слідуй за мною). Інструмент фактично є просунутим варіантом попереднього: те ж 

вичавлювання площини 2D-фігури (профілю), але вже по певній напрямній лінії (вздовж шляху). При цьому 

профілем видавлювання може бути будь-яка поверхня (Face), а напрямною (Path) – будь-яка одиночна лінія-
ребро (пряма чи ламана) або ребро іншої поверхні. Залежно від особливостей геометрії конкретного об'єкта 

можна використовувати кілька різних варіантів (прийомів) роботи з інструментом [3, 5]. 

Випадок видавлювання профілю (шестикутника у прикладі) по дорозі – одиночної кривої лінії: 

 

 
Рис. 5. Приклад роботи інструменту «Follow me»  

 

Тут застосовано перший спосіб, який можна назвати «ручним». Вибираємо інструмент (клацаємо 

кнопку) – з'являється курсор у вигляді цього інструменту > поміщаємо курсор на профіль, тим самим 

вибираючи його > утримуючи кнопку мишки, акуратно тягнемо профіль по напрямній (вона підсвічується 

червоним кольором) > відпускаємо кнопку в кінцевій точці напрямної, завершуючи створення об'єкта. 
Move (переміщення). Це один з найбільш затребуваних інструментів SketchUp, використовується 

для переміщення будь-яких об'єктів і елементів побудов, а також має ще кілька додаткових потужних 

функцій. Тут працюють ті ж два способи (послідовності) виконання опції вибору об'єкта впливу, аналогічні 

інструменту Push/Pull – без попереднього вибору, якщо нічого не вибрано до цього, і з попереднім 

зазначенням об'єкта його вибором. Рух супроводжується тимчасовою точковою лінією, що підказує 

напрямок переміщення, – червоною, зеленою, синьою, якщо рухаємося по осях, або чорною у всіх інших 

напрямках. Ще одна дуже чудова функція інструменту - можливість одночасного з переміщенням 

дублювання елемента, що переміщається (підказка: «Ctrl = Toggle Copy»). Тобто з натиснутою кнопкою Ctrl 

переміщається не сам обраний елемент, а його копія, а оригінал залишається на місці. При цьому, 

з'являється ще одна підказка – символ «+». 

Rotate (обертання). Інструмент обертання об'єктів «повністю» або їх спотворення за рахунок 

обертання окремих елементів побудов. Після вибору інструмента (клік на кнопці) стандартний курсор 
змінюється на зображення інструменту Protractor (Транспортир) з круговими стрілками. Робота Protractor, як 

і інших інструментів модифікацій, контролюється точними числовими вимірами (кутовими величинами). 

Взагалі, можливі два варіанти роботи інструменту: перший – коли курсор (а також площина та центр 

обертання) знаходиться поза об'єктом, у порожньому просторі сцени. Другий варіант – центр обертання має 

бути на самому об'єкті. При цьому курсор автоматично прагне «лягти» на одну з поверхонь об'єкта під ним: 

якщо її орієнтація збігається з одним з планів осей, курсор «забарвиться» у цей колір. У решті випадків – 

залишиться чорного кольору, показуючи, що площина обертання не збігається з жодним із планів осей [3]. 

Якщо центр і площина обертання повинні знаходитися на самому об'єкті, досить просто помістити 

курсор Rotate на потрібну поверхню (грань) об'єкта - при цьому одночасно відбувається вибір елемента під 

курсором (поверхні або ребра), так що немає необхідності в попередньому виборі. Наступний крок після 

встановлення курсора в потрібне положення: першим кліком вказуємо (фіксуємо) центр обертання > 
переміщенням курсору (без натискання кнопки мишки) «витягуємо» пунктирну лінію, вказуючи положення 

вихідного (першого) променя кута повороту і другим кліком фіксуємо його > переміщенням курсора (без 

натискання кнопки мишки) повертаємо об'єкт на потрібний кут > третім кліком завершуємо опцію. Якщо 

центр обертання знаходиться поза об'єктом, потрібно попередньо вибирати об'єкт (елемент об'єкта) 



 Технічні науки ISSN 2307-5732 
 

Вісник Хмельницького національного університету, №1, 2022 (305) 57 

інструментом Select (вказуючи, що саме його будемо обертати), а вже потім включати та налаштовувати 

інструмент Rotate. Звичайно, попередній вибір буде потрібен і при призначенні повороту кільком об'єктам 

одночасно. 

 

 
Рис. 6. Приклад роботи інструменту «Rotate» 

 

Scale (масштабування). Інструмент використовується для зміни розмірів та пропорцій об'єктів 

повністю та їх окремих елементів для спотворення. Для надання об'єкту майбутнього масштабування 

можливі два варіанти вибору: можна або заздалегідь вибрати його інструментом Select, а потім вибрати 

інструмент кліком на кнопці (стандартний курсор змінюється на зображення інструменту), або спочатку 

увімкнути інструмент, а потім клацнути його курсором на об'єкті (елементі). Необхідно пам'ятати 

принципове обмеження механізму масштабування SketchUp – він працює тільки й завжди за напрямками 

осей сцени (червоної, зеленої синьої). 
Group (група). Завдання створення «фізично повноцінного» об'єкта вирішує найважливіша опція 

SketchUp – Make Group (Створити групу). Група – це пов'язана в єдине ціле комбінація будь-яких (зокрема 

за розташуванням у сцені) елементів побудов, які за групуванням сприймаються програмою як об'єкт. Тобто 

для його вибору достатньо одного кліка інструментом Select на будь-якому з її елементів, частин. 

Все, що стосується групи, відноситься і до іншого, «родинного» механізму – Components (Компоненти), 

які фактично є модифікацією Груп, тобто мають всі ті самі властивості та можливості, плюс свої специфічні. 

Отже, група створюється вибором потрібних елементів (об'єктів) та застосуванням команди меню Edit > Make 

Group чи аналогічною – з контекстного меню обраного. Зворотна опція (розрив групи) доступна з меню Edit > 

Group > Explode або з аналогічного пункту контекстного меню раніше створеної групи. 

Головна відмінність групи від простого набору окремих елементів і головна перевага полягає в 

тому, що з моменту угруповання не тільки народжується єдиний об'єкт, але він ще й фізично 

відокремлюється від інших елементів моделі. Очевидно, що набагато простіше (особливо у складній сцені) 
працювати з групами-об'єктами, ніж з розрізненими ребрами та поверхнями – починаючи з опцій вибору і 

закінчуючи будь-якими діями з ними. Зрозуміло, що всі опції модифікацій будуть впливати на групу як 

єдине ціле, тобто на всі об'єкти, що містять її, одночасно і з однаковими параметрами. Наочна ілюстрація – 

групи мають дуже зручну функцію «розвороту будинку», точніше навколо геометричного центру групи. Це 

робиться за допомогою інструменту Move. Активуємо інструмент і поміщаємо його курсор на одну з 

поверхонь габариту об'єкта (сині лінії) – 

з'являється зображення Protractor, а 

фактично інструменту обертання Move та 

чотири червоні хрестики-маркери, за які 

можна повернути групу в цій площині. 

Площини габаритного боксу завжди є 
паралельними планам осей сцени 

незалежно від об'єктів його вмісту та 

орієнтації в сцені [3, 5]. 

Групи мають ще кілька 

унікальних можливостей щодо 

модифікацій та призначення матеріалів. 

Звичайно, підхід до моделювання як до 

створення фізично реальних об'єктів можливий тільки з використанням груп, які можуть мати індивідуальні, 

значущі «імена». Отже, насамперед для створення групи треба вибрати все те, що має увійти. Можна не 

позначати кожну поверхню і ребро (використовуючи + Shift - множинний вибір) - занадто довго і незручно, 

а скористатися «прямокутником» вибору. Однак часті випадки, коли і такий спосіб незручний, не підходить. 
Наприклад, якщо за потрібним об'єктом знаходяться інші, і ми їх бачимо (або їх окремі елементи) у 

поточному ракурсі камери – вони також потраплять до зони вибору. Звичайно, повернувши камеру, можна 

«зловити» потрібний ракурс, але і цей спосіб може вимагати нераціональних маніпуляцій. 

У SketchUp є можливість зберегти наш файл, призначивши місце на жорсткому диску (краще – в 

окрему папку) та ім'я – наприклад, «dom_0». І з цього моменту почне працювати опція автозбереження, що 

допоможе не втратити виконану роботу у разі непередбачених проблем. Слід зазначити, що SketchUp 

 
Рис. 7. Приклад роботи інструменту «Group» 
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підтримує кирилицю, і ми можемо працювати не тільки з українськими/російськими іменами файлів, але і з 

введенням будь-яких текстових даних та з іншими, «внутрішніми» опціями. Однак згодом можуть 

виникнути  проблеми при передачі моделі в інші 3D-редактори та рендери, які в більшості «не розуміють» 

кирилицю. Тому, якщо передбачається подальша робота з моделлю не тільки в SketchUp, краще 

використовувати лише латиницю в іменах файлів і деяких інших опціях. Крім того, і повний шлях до файлу 

у файловій системі повинен містити тільки латинські букви. Наприклад, призначаємо місце збереження 

файлів таким чином: – D:\DOM\dom_0. 

Ми можемо звично зберегти файл поточного проекту через пункт головного меню (File > Save) і 

виконувати інші дії з файлами через основні текстові меню. Проте зручніше і швидше все-таки 

користуватися кнопками інструментів, тому має сенс «викликати» панель управління файлами, що постійно 
використовується, і рядом інших опцій у наш інтерфейс: – View > Toolbars > Standard. Кнопки цієї панелі 

запускають типові для програм під Windows опції меню роботи з файлами та редагування: – File: New, Open, 

Save, Cut, Print; – Edit: Copy, Paste, Erase, Undo, Redo. Опції Undo/Redo (Скасувати/Повторити) допомагають 

швидко (покроково назад/вперед) скасувати попередні помилкові дії або скасувати попередні скасування. 

Причому кількість доступних кроків скасування не регламентована [3, 5]. 

Потрібно сказати, що потужние зростання популярності SketchUp сталося з моменту «прив'язки» 

програми до інтернет-проектів нового власника – Google 3D-моделі 

(http://SketchUp.Google.com/3dwarehouse/) та Google планета Земля (http://earth.Google.com/intl/ru/). Для 

взаємодії з цими проектами у SketchUp вбудовані спеціальні опції та інструменти. Причиною вибору та 

придбання SketchUp корпорацією Google стали його простота та доступність. Створивши в SketchUp модель 

архітектурної споруди чи будь-яких інших об'єктів, користувачі могли розміщувати свої творіння в 
загальнодоступних онлайн колекціях Google. Так, зокрема, підбірка колекцій «Города в разработке» містить 

декілька тисяч моделей реальних архітектурних будівель світу. Причому, компанія Google приймала 3D-

моделі тільки з вимогою, що вони текстуровані та оснащені правильною географічною прив'язкою. 

 

Висновки з даного дослідження і перспективи подальших розвідок у даному напрямі 

3D-моделі представляють 3D-об'єкт використовуючи набір точок в 3D-просторі, поєднаних між 

собою різноманітними геометричними об'єктами, наприклад, трикутниками, лініями тощо. У комп'ютерній 

графіці 3D-моделювання – це процес розробки математичного представлення будь-якої тривимірної 

поверхні об'єкта за допомогою спеціалізованого ПЗ. Продукт моделювання може бути представлена у 

вигляді програмного коду або відображена у вюпорті чи вювері, як тривимірна модель, а також за 

допомогою двовимірного зображення, що створюється за допомогою процесу рендерингу. 3D-моделі 
можуть створюватись вручну або автоматично, у тому числі за допомогою 3D-сканера. 

SketchUp - програма для моделювання, що підтримує 2D та 3D моделі [3, 5]. У порівнянні з багатьма 

іншими популярними пакетами, SketchUp володіє рядом особливостей, що позиціонуються як переваги. 

Основною особливістю цієї програми є майже повна відсутність вікон попередніх налаштувань. Всі 

геометричні характеристики під час або зразу після закінчення дії інструменту задаються з клавіатури в поле 

Value Control Box (поле контролю параметрів), яке знаходиться в правому нижньому кутку робочої області, 

справа від напису Measurements (панель вимірів). Ще однією ключовою особливістю є інструмент Push/Pull 

(Тягни/Штовхай), завдяки якому будь-яку площину можна «витягнути» в сторону, створивши по мірі її руху 

нові бокові стінки. Рухати площину можна впритик до наперед заданої кривої, для цього служить 

спеціальний інструмент Follow Me. Також програма характеризується надзвичайною точністю прорахунків 

та вимірювань. 
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